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Chapter 1 Introduction

Purpose
This publication explains the history and conventions of 
publications for the ValuBond platform.

Intended Audience
This publication is written for follow-on writers or editors of the 
ValuBond family of technical publications.

General Comments
» Note: For answers not provided in these pages, email 
valubondquery@johnsonstudios.com. I will answer as quickly as 
possible.

A first-person narrative describing a technical publications 
program may be unusual. I decided to write one because in past 
assignments I’ve inherited tasks with no historical reference. 
The turnover in the technology industry adds confusion and a 
lack of history to development efforts. My goal in this document 
is to describe the ValuBond platform and its supporting 
documentation.

I was ValuBond’s technical writer from 10/2000 until the 
contract’s end in 5/2001.

The ValuBond platform is in solid shape for further 
documentation. This is the first time in my life as a technical 
writer that a project of this scope has actually been completed, 
let alone activated for commercial trading. There have been 
incremental changes, but they all make sense, are client-driven, 
and the programming team has kept good internal notes.

ValuBond, Incorporated, was founded to bring online trading to 
the bond market. In the Summer of 2000, ValuBond hired a 
contract team of technical specialists to build the hardware and 
software mechanism. I was hired for a “two week contract” to 
produce a small set of training materials. These materials were 
to be for three audiences:
  Release 2.5 — 05/2001
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• Administrators who perform account maintenance and 
post new bond issues for sale on the platform

• “Relationship managers” who oversee strategic business 
partnerships. The partners are called “subscribers” in 
company parlance; for more on this see “User And 
Subscriber Terms” on page 6-2.

• General site users

In the original two weeks, I produced the training documents 
and conducted the first training classes. 

A Security Policy (required by partnership agreements) was 
added to the schedule. Since the ValuBond platform was 
evolving quickly, I wrote a quick policy based on Requests for 
Comment found on the Internet, security materials at the 
National Institute of Standards and Technology, and my own 
background as a former intelligence officer. The final Security 
Policy was updated and released in March 2001.

By mid-October 2000, the technical and project managers 
realized that they needed more publications than those 
produced in a two-week period. The following titles were 
ultimately added to my scope, and were revised with each 
modification of the platform:

Demonstration Guide

Runbook (a system administration manual)

Quickstart Guide (for subscribers)

Platform Changes and Updates
The development team uses a bug tracking system called Web 
Tracker. See the project manager for access. 

Style References
• The Chicago Manual of Style, Fourteenth Edition, 1993.

• The Microsoft Manual of Style for Technical Publications, 
Second Edition, 1998.

• Microsoft Word and Adobe FrameMaker templates from 
past assignments.
  Release 2.5 — 05/2001
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Organization
This publication is organized as follows.

This introduction explains the basics of the book.

Chapter 2, “Site Information and Key Business Processes” 
contains information on the ValuBond platform’s logical 
components.

Chapter 3, “File Locations” explains where source and 
production files are.

Chapter 4, “Chronology of Publications” is a history of ValuBond 
technical publications from October 2000 – May 2001.

Chapter 5, “Software” is a brief description of ValuBond’s 
publishing tools.

Chapter 6, “Style” discusses lexical and design style for 
ValuBond’s technical publications.

Chapter 7, “Typefaces and Fonts” discusses ValuBond’s 
typography and the use of required PostScript and TrueType 
fonts.
  Release 2.5 — 05/2001
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Chapter 4 Chronology of 
Publications

Overview
This chapter is a time line of the ValuBond technical 
publications program from October 2000 – May 2001.
  Release 2.5 — 05/2001
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Word Templates
These were imported from previous work in converting Frame documents 
to Word. They served as the style source for New Issues Training, Site 
Training, and the Demonstration Guide from October – December 2000.

Frame Templates
Like the Word templates, these were from a previous job. They were the 
basis for the Runbook and Security Policy from January – May 2001.

New Issues Training
This was the first document written, October 2000. It was for the trading 
desk administrators in Nashville. It was done in MS Word.

Site Training
This was the second document written, again for trading desk employees 
in Nashville, in November 2000. It was intended for a “train-the-trainer” 
program for partnering companies such as Schwab, but this was never 
implemented. The directories have a hierarchy of three levels that mirror 
the original, though unrealized, tiers of training materials.

Demonstration Guide
This was done in December 2000, based on business notes and PowerPoint 
presentations. It was published to provide a standardized script, and also 
to be a surrogate site demonstration directly from a laptop should network 
connectivity fail during a marketing presentation.

Security Policy
The first version was done in October 2000 to meet a business 
requirement. The second version was completed in more detail in March 
2001.

Runbook
The Runbook was done in several iterations from January – April 2001. It 
is a work-in-progress, so the PDF still bears the Draft watermark.
  Release 2.5 — 05/2001
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Quickstart Guides
Quickstart Guides are for business partners such as Schwab and J.P. 
Morgan. The guides introduce traders to the functions of the ValuBond 
platform. The emphasis is on secondary market trades. The typography 
and layout are a departure from the templates; topic headings are on 
vertical baselines in the left margin, and body and title type is in a faux 
(TrueType) Gill Sans called Guilford.

ValuBond Publication Notes
This is the volume you are reading now; it was written in May 2001.

Data Dictionary 
As referenced in “Data Dictionary” on page 3-1, the Data Dictionary is not 
a publication per se. The database field definitions and table 
characteristics are in a dynamic format that displays in HTML. See the 
Database Administrator (DBA) for details and access.
  Release 2.5 — 05/2001
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Chapter 6 Style

Overview
In October 2000, ValuBond chose Microsoft Word for publishing. 
This presented several difficulties. First, there were no existing 
templates. Second, Word is difficult to use and merge into 
complex volumes; the “master document” feature simply doesn’t 
work, and things like tables of contents and indexes across 
multiple chapters are work-arounds.

I used existing templates from a previous assignment, given the 
time crunch, and tried to make them as robust as possible.

In January 2001, ValuBond purchased FrameMaker 6.0. I 
adapted functioning templates from an earlier assignment.
  Release 2.5 — 05/2001
            6-1



Technical Publications Chapter 6
Production Notes Style
Manuals of Style
Conflicts arise from the use of two manuals of style, in this case, Chicago 
and Microsoft. The most direct contradiction is in the use of a solidus or 
slash to designate alternatives such as yes/no. Microsoft is set against this 
construction, while Chicago allows it. At ValuBond, it made sense to 
incorporate the slash in the flow of product descriptions.

There are other deviations that made visual sense but which violated 
Microsoft’s style guidelines. For example, Microsoft feels that command or 
literal input text should simply be capitalized; the ValuBond publications 
place the text in monospace bold for clarity. For the documents 
published in FrameMaker, apply the paragraph catalog tag “command.” 
Also, em and en dashes do not touch adjacent text, contrary to Chicago.

Lexicon and Business Terminology

User And Subscriber Terms

Users. This term has evolved to several different categories. Different 
categories equate to different access privileges on the ValuBond platform.

• Individual users are individual investors.

• Registered users can use the Bond Research tools, but can not trade.

Subscribers. Companies that partner with one another are logically called 
partners, or sometimes strategic partners. ValuBond’s original contractual 
documents describe these entities as subscribers for reasons that are not 
entirely clear. Thus the term is used to describe partnership 
arrangements. There are three categories of subscribers.

• Brokers can see the Live Bond Offerings but can neither buy nor 
sell.

• Traders can see the Live Bond Offerings, and can buy and sell.

• Administrators can post New Issue orders, as if from the ValuBond 
trade desk.
  Release 2.5 — 05/2001
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Disclaimers

Financial trading companies have their own set of governors and industry 
regulators. Thus, ValuBond has legal restrictions on operations and some 
cautions on what is published.

Front Matter

The front matter disclaimer is for the protection of copyright, trade secrets, 
and the limitation of liability. 

» Note: The Frame version contains variables such as addresses and 
company names. Click on the text in the Frame source files to highlight a 
variable. 
For further information about this manual or other products, contact the Customer Support 
Department, ValuBond, Inc., 3405 Piedmont Road, Atlanta, Georgia 30305, (404) 264-2420, (877) 392 - 
VALU (8258).

ValuBond welcomes your opinion regarding this document. Please email your comments and 
suggestions to support@valubond.com or send them to the Customer Support address shown above.

Copyright © 2001, ValuBond, Inc., All rights reserved.

Proprietary Notice

This document is an unpublished work containing confidential and trade secret information, which is 
proprietary to ValuBond, Inc. (“ValuBond”), and is protected by laws pertaining to such materials. The 
information in this document and all rights thereto are the sole and exclusive property of ValuBond, 
Inc. and are intended for use by customers and employees of ValuBond, Inc., and are not to be copied, 
used, or disclosed to anyone else, in whole or in part, without the express written permission of 
ValuBond, Inc. For authorization from ValuBond, Inc. to copy this information, please call ValuBond 
Customer Support at (404) 264-2420, or (877) 392 - VALU (8258). 

VALUBOND EXTENDS NO WARRANTIES REGARDING THIS DOCUMENT, EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. ValuBond, Inc. shall have no 
liability to the user of this document for any damages of any nature whatsoever including, but not 
limited to direct, indirect, incidental, or consequential damages, even if ValuBond, Inc. is advised of the 
possibility of such damages or for loss of use or other commercial loss (including but not limited to, loss 
of revenues and/or profits), however occasioned and whatever the form of action, for actual or imputed 
negligence, breach of contract, breach of warranty, or otherwise.

In addition, the page footers of internal documents are marked (as are 
those in this volume) with a general caution statement. This statement is 
a Frame variable and will automatically update below if changed.

This page contains ValuBond proprietary information and is not to be duplicated or disclosed to unauthorized persons.

External

External documents have a specified text that is always appended, usually 
in the footer.

All transactions are conducted through ValuBond Securities, Inc. member NASD/SIPC, a 
wholly-owned subsidiary of ValuBond. System response and access times may vary due to 
market conditions, system performance, or other factors.
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Templates
There was neither time nor a requirement to construct custom templates. I 
relied on Word and FrameMaker templates from a previous job. The 
templates had similar look-and-feel.

FrameMaker is inherently more stable than Microsoft Word. FrameMaker 
is a professional publishing tool; Word is not. 

Each publishing job has unique requirements. The final templates have 
minor modifications that reflect ValuBond’s needs. The resulting chapters 
(in the case of Word documents) and books (for FrameMaker) have 
templates that are reasonably resilient. The Word chapters have minor 
variations; resaving and reapplying styles often changes the file in 
unpredictable ways that are the bane of every technical publisher.

FrameMaker Templates

FrameMaker allows character, paragraph, table, and a host of other styles 
and applies and updates them efficiently. 

The FrameMaker volumes have

• A title file with the title page and main internal disclaimer

• A table of contents

• Chapter files

• Appendix files

• An index

» Note: The Runbook has a full set of files for copying and renaming into a 
new book.

� To make a new book from existing Frame files

1. Copy book, title, chapter, and appendix files into a new directory.

2. Rename the book file to the new volume name.

3. Open files and rename variables.

4. Flow new text, headings, and so on into new files.

5. Copy files (such as chapters) as needed, and import variables.

6. Generate TOC and index.

7. Delete new TOC and index, and rename TOC and index from previous 
volume to mirror newly-generated names.

8. Regenerate and save the book.
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The Chapter and Appendix files have master pages for both portrait and 
landscape orientation. The title pages have no header and have an H1 
heading and automatic chapter numbering. Title pages also have a 
narrower text column. This is to place summary or introductory 
information at the front of the chapter and enhance readability by 
presenting fewer characters per column inch. Follow-on pages have a 
wider text column to put more information on the pages.

Word Templates

The Word documents are not linked to a root template. Creating new 
documents and linking them to a template directory is not a guarantee of 
stable files. Instead, the files are copied into new directories and existing 
text is replaced with new text. This seems to preserve typographic styles, 
though there are still the usual problems with Format > Bullets and 
Numbering.

As mentioned, using Word to make a composite document isn’t always 
easy. The master document feature is supposed to allow dynamic 
embedding, but never works. When composing a PDF, naturally, you must 
save each file as a separate PDF and concatenate them in Acrobat to make 
a composite document. This involves adding extra blank pages, if 
necessary, to force an even page count for each chapter. I will describe this 
process below.

A Word “book” contains the following files:

Frontmatter.doc

The Word front matter combines several of the files that are separate in 
the Frame versions of these books. It has a title page, a copyright and 
disclaimer page, and a table of contents (TOC). The TOC is inserted from 
the Insert > Index and Tables menu. At the end of the TOC are “RD” 
(“read”) statements that correspond to the names and paths of the 
chapters in the book. When the TOC is built or updated, Word reads the 
statements and extracts the headings down to the appropriate level and 
appends them and their respective page numbers to the TOC.

» Note: For a new TOC, open an older TOC file and Save As a new file in a 
new directory. Attaching a template is possible, but this could be courting 
disaster with changed styles and unanticipated excitement through MS 
Word.

� To set up a Word TOC with RD statements

1. Insert a Table of Contents in the desired place (or use a previous set of 
TOC fields by copying a frontmatter.doc file into a new directory).

2. Insert > Field > (scroll in dialog box to “RD” and enter filename or 
path).

{RD Introduction.doc}
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{RD First Chapter.doc}

And so on.

3. For simplicity’s sake, it’s best to keep all files in the same directory, so 
that the paths in the RD statements can be absolute. If files are to be 
read in other directories, specify the path in the RD statement like 
this:

{RD C:\directoryname\filename.doc}

� To rebuild the Word TOC (and the index)

1. Quit Word.

» Note: If rebuilding the TOC (or index) produces “ERROR! Cannot open 
file referenced on page nn,” quit Word and reopen only the file to be 
updated. Word has a nasty habit of failing to regenerate lists if the file is 
not opened first. It's smart to quit Word again and then open the next files 
to continue work.

2. Reopen frontmatter.doc.

3. Position the cursor in any of the gray TOC fields.

4. Press F9 to update. 

<Chaptername>.doc

As with the front matter (frontmatter.doc), it’s probably best to copy a 
chapter with correct styles and numbering into a new directory and 
rename it, rather than risk attaching a separate template and corrupting 
the file.

Index.doc

The index (index.doc) should probably be copied from a reliable Word index 
file to a new directory for a new project. 

� To make an index

1. Cut-and-paste the list of RD Statement fields from the manual’s 
fontmatter.doc table of contents to the bottom of the index (below the 
Word index fields). 

2. To update the index, place the cursor in one of the gray Word index 
fields and press F9. Word should read the RD statements, open the 
called files, compile the index fields, and populate the index.

3. If this doesn’t work

a. Close the index file after saving.

b. Quit MS Word.

c. Open the index file.
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d. Doing nothing else, place the cursor in a gray Word index field.

e. Press F9.

This should rebuild the index. 

» Note: When failure occurs, always quit MS Word, reopen only the file you 
wish to update, and follow the update procedure.

Production Topics

Frame to PDF (Portable Document Format)

Select Acrobat Distiller as the default printer and use Frame’s Print Book 
feature to produce a PostScript file. Distil the PostScript file and save as a 
PDF.

Word-to-PDF

� To make a composite PDF from Word

1. Build all TOCs and indexes.

2. Distill the separate files as PDFs.

3. Open Acrobat.

4. Starting with the frontmatter.pdf, import successive chapter PDFs, 
adding blank pages as necessary to force even page counts for each 
chapter and for the volume.

Corporate Identity and Technical Publications Design
ValuBond’s logo development and identity book were done by a marketing 
and public relations firm. I have added a directory of marketing graphics 
to the legacy directories. The logos use mostly Copperplate and some sans 
serif typefaces and can be recreated on the fly if necessary. ValuBond to 
date hasn’t put the strictures on logo use that, say, General Electric has. 
Part of this is an open acceptance of a growing marketing program, and 
part is due to a change in business image. For example, several of the logo 
typographic treatments show a Uniform Resource Locator for the Internet 
(www.valubond.com); in 2001 this “dot com” association became less 
desirable.

There is sparse use of identity graphics in the technical publications to 
date. A version of the ValuBond logo is normally in the lower-right corner 
of the cover page. The Quickstart Guide repeats this treatment on each of 
its two pages.
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Thus, there is much design freedom in making ValuBond’s technical and 
training documentation. The current volumes are based on several 
concepts:

• Readable body text in serif typefaces, headings in sans-serif. 
Exceptions to this are the body text in the Quickstart guides 
(presents a slicker visual appeal), and the presenter's notes in the 
Presentation Guide.

– The Word template uses 11-point New Century Schoolbook with 
no real typographic control on leading.

– The FrameMaker template uses 11-point New Century 
Schoolbook on 13-point leading.

• Generous use of white space

• Non-numbered headings

• Simple use of navigation information; titles, document types, 
release numbers, and effective dates in headers and footers

• Minimal use of graphics, mostly confined to horizontal rules and 
screen captures

• Use of sans serif type on vertical baselines in the margins as heads 
in the Quickstart Guides
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6-8  



Chapter 7 Typefaces and Fonts

Overview
Chapter 6, “Style” describes design decisions for ValuBond’s 
publications; font usage is simple and fonts are few in number. 
The main typefaces and fonts used in the ValuBond technical 
publications are:

Headings: Adobe PostScript Helvetica. 

Body Text: Adobe PostScript New Century Schoolbook

Specialty Sans Serif: Guilford True Type
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Project Fonts
The project fonts are in the directory shown.

Adobe Type Manager (ATM)
The PostScript fonts must be activated for use in Word and FrameMaker 
with Adobe Type Manager (ATM). ATM is available free for download from 
www.adobe.com/products/atm.

� To install the ValuBond documentation font set

1. Unzip the file PSFONTS.zip in the root directory of your local drive. 
This creates a PSFONT directory of font files ending with the 
extension .pfb, and a directory called PFM containing font files with 
the extension .pfm.

» Note: PostScript fonts have two parts, a screen font for display on the 
monitor and a print font that contains the mathematical characteristics of 
each letter in a character set. When a PostScript font in a document is 
printed, the print font measurements are sent to the printer or other output 
device. This ensures accurate typesetting. Adobe Type Manager (ATM) is a 
font management tool for PostScript fonts. ATM “smooths” the rasterized 
fonts on the monitor and makes the printer fonts available.
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2. Download and install Adobe Type Manager (ATM). When you have 
done that, or if it is already installed, open ATM.

3. Select the Fonts tab. 

4. In the drop-down list box Source, select Browse for Fonts.

5. In the drop-down list box below Source, click the drop-down tab and 
navigate to, and double-click on, the PS FONTS folder on your C: drive.

6. Select the available fonts (font names displaying the “a” icon) and click 
Add.

7. Double-click and open the PFM folder.

8. Select the font names displayed and click Add.
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9. Select the Settings tab. The settings and information should be similar 
to those in the screen below.
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Production with Acrobat
Adobe Acrobat, because it relies on PostScript, functions well with ATM 
and PostScript fonts. It also embeds True Type fonts in the document and 
approximates the font metrics to make standard output.

Acrobat files can be printed locally, displayed on screens across a network 
or remotely by web browser, or sent for commercial reproduction. As of this 
writing, ValuBond has an account with Kinko’s for printing. Use File 
Transfer Protocol (FTP) to send the PDF file for reproduction. 

» Note: When using a print vendor, select a heavy grade of paper, normally 
60-pound, for best results. If selecting paper for three-hole binders, request 
3/8-inch drill. It costs more but the results are superior to the 1/4-inch 
punched bond paper. The 1/4-inch tears and frays more, often making a 
poor impression.

� To configure Distiller for ValuBond publishing

1. Open Distiller > Settings > Job Options

2. Click the Compression tab and set the parameters as shown below.
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3. Click the Fonts tab and set the parameters as shown below.
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